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CAD tool for mask designs – beginners guide 
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Anders M. Jorgensen – amj@mic.dtu.dk 

 

1 Introduction 
This beginners guide for the photolithographic mask design program L-Edit from Tanner research 
(USA) was initially written for use in the course “Micro and nano fabrication” at MIC in the fall 
semester of 2003. The guide is intended to give the reader a basic understanding of photolithographic 
mask designs and of how to use the L-Edit program. To really be proficient in the use of any computer 
program practice is needed and the reader is strongly recommended to do so. 
The Introduction has been revised with a couple of sections added for the fall semester of 2004. Most 
noticeably are the sections concerning insertion of text and the exercises. 
Minor corrections in the 2005 revision, parts of the exercises removed. 
This note is intended as an educational aid, any feedback is highly appreciated. 

2 General considerations for mask designs 
Before delving into the actual design of a mask set with L-Edit it may be worthwhile to clarify a few 
issues, such as what is a photolithographic mask set and why should you learn to use a computer aided 
design (CAD) tool and in particular why L-Edit? 

2.1 What is a photolithographic mask set? 
A photolithographic mask set is a series of photo masks containing patterns for all the masking steps 
needed to realize a particular component. The number of masks in a MEMS mask set can vary from 
one to about fifteen.  
In general it is advantageous to keep the number of photo masks low, since the whole 
photolithographic cycle is both time consuming and expensive. On the other hand, sometimes more 
masks should be used simply because it will make processing a lot easier. 

2.1.1 Photo masks 
A photolithographic mask is normally a glass plate with chromium patterns. The chromium patterns 
serve as areas where light cannot pass through. A mask can be fabricated in several ways. One cost 
effective approach is to use laser writing, this limits the linewidth to about 1.5 µm and the price is 
about 200 € per 125 mm mask, usually a delivery time of 1-3 weeks can be expected. If a finer 
linewidth is needed electron beam written masks can be used. These have a linewidth of approximately 
200 nm however the price increases up to about 3000 € per 125 mm mask with an expected delivery of 
several months. Further reductions in linewidth require different masking techniques usually only 
employed by the microelectronics industry; these techniques are very expensive and complex usually 
requiring steppers or even direct e-beam writing. Cheaper and simpler solutions also exist; 
transparencies for overhead projectors are often used for simple and crude structures. A laserprinter 
with a 600dpi resolution creates dots of approximately 40 µm and a 4800dpi printer will give dots of 6 
µm. Two to three dots are required to have a reasonable pattern so these systems can be used to give 
linewidths of 120 µm and 20 µm respectively. The price for such masks is a couple of euro for the 
600dpi version and some 50 € for the 4800dpi version. Masks based on transparencies suffer from a 
couple of drawbacks: they are very hard to clean and their dimensional stability is poor, due to warping 
of the flexible transparency. The problem with dimensional stability has considerable impact on the 
alignment precision. Alignment of transparency masks becomes very hard if the precision needed is 
better than ~200 µm (on a 100 mm wafer). The drawbacks of masks based on transparencies can be 
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overcome by transferring the pattern from an overhead mask to a glass substrate covered with 
chromium and photoresist. When developed and the chromium is etched the formed mask can be used 
just like a laser written or e-beam mask, and also cleaned using the same cleaning methods. 
 

2.2 Hierarchy layout 
Good mask design practice involves creating mask set which are as simple as possible to understand. 
This is both from the mask file point of view as well as understanding the wafer development during 
processing. When designing masks it is important to understand that the final result of the mask 
designing process is a series of physical masks. This is usually implemented as layers in the design 
program. Each layer can then be used to fabricate one mask. In the program the layers usually have 
different colors, however, even if two layers have the same color the patterns will end up on two 
different masks. This point is also important when considering the result of overlapping structures. If 
two structures on different layers overlap the individual patterns will end up on individual masks. This 
means that overlapping does not shade structures from each other.  
The layout program handles a lot of information and helps organize very complicated structures 
through the use of cells and instances. A “cell” is a pattern, which can contain patterns on some or all 
of the layers in the design. The pattern described in the cell can be of any size. The cell can then be 
instanced (inserted) several places in the design, but still only be defined once. Cells are used to keep 
the design consistent, making it easy to update and keep the file size down. 
Consider for example a structure where the chip size is 10 mm by 20 mm (Figure 1) on a 100 mm 
wafer there could be 21 chips. On this chip, there are four fluidic access points called vias. When using 
cells the fluidic via can be defined as one cell and then instanced 4 times in another cell containing the 
chip. Finally, the chip is then instanced 21 times to create the final layout. 
Compare this to the situation where the drawn structures are merely copied, it would require the 
information for drawing the chip 21 times with the fluidic via being drawn 84 times. Imagine for these 
two situations that the pattern for the fluidic via had to be changed. Using the cell approach, the change 
could be made in the cell and then automatically updated throughout the layout. If the design had been 
copied 84 times instead, these copies of the old fluidic via has to be deleted and then the new pattern 
should be copied again. If in doubt whether or not to define a cell for a structure, you should definitely 
make a cell. 

 

Figure 1: The figure shows the concept 
of hierarchy in a mask design. 

2.3 Why use a CAD program for mask designs (why L-Edit)? 
The main requirements for the program used for drawing structures is that is should be able to handle 
cells and the various length scales involved in mask design. On the macroscopic end of the length scale 
there is the complete mask, which usually covers a 100 by 100 mm area, you should be able to see this. 
On the microscopic end of the length scale there is the need to draw structures of 1 µm or even less. 
This means that the zoom range should be something like 104 to 105. For non-CAD drawing programs 
such high zoom ranges are cumbersome at best and impossible at worst. A further difference is that 
when designing masks there will often be an overlap of structures on the different mask layers. These 
overlaps are usually important and therefore the structures on one layer should not overwrite the other 
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structure. For mask making CAD programs, this is handled by assigning a different color to overlap 
regions to make it clearer.  
L-Edit is a very powerful program and generally, MEMS and BioMEMS designs only use a fraction of 
the capabilities. The most important aspects of L-Edit is the substantial expertise developed for using it 
and the approach to handling cells and instances of cells. L-Edit is the preferred mask design software 
at MIC. 

3 Installation of L-Edit 
When making complex mask designs using L-Edit, most personal computers are pushed to their 
performance limit. Due to the graphical nature of L-Edit it is mainly the video card, which is the 
bottleneck in most configurations. 
The operating system should be Microsoft Windows 2000 or XP. If Windows 2000 is used make sure a 
service pack later than SP2 is installed (this is due to a bug). Computers on the MIC local area network 
can install the latest version of L-Edit from the server “micdat2”. 
L-Edit mainly puts a strain on the graphics capabilities of the computer. The better a 2D graphics 
adapter the easier it is to work with. Make sure the computer you are using has the latest graphics 
driver installed and at least 2D hardware accelerator enabled.  The computer I used for designing masks 
was quite reasonable, although not fantastic: 
 Pentium III, 833 MHz 
 256 Mb RAM 
 1024x768 monitor @ 85 Hz refresh, 17” CRT 
 Onboard Graphics adapter Intel 82815, 4 Mb RAM 
 Logitech MX500 optical mouse 
The graphics adapter was really not up to the job and that is why the monitor was only operated at 
1024x768 mode. If you have a higher resolution monitor/adapter system, it is much easier to navigate 
the designs. 
I have now changed to another computer (Compaq NX7000), which is very good for mask designing: 

Intel Centrino 1.5 GHz 
512 Mb Ram 
1680 x1050 pixels (flat screen) 
Mobility Radeon 9200 graphics adapter, 64 Mb ram 
Logitech MX500 optical mouse 

 

3.1 How to avoid injury when using a computer mouse 
A computer mouse is a nice tool and for mask design; and it is the most often used drawing device. 
However, extended use of a computer mouse is not healthy. Often people will place themselves in a 
position where their mouse arm is not relaxed, this forces the shoulder to lift the arm all the time. 
Typically, the symptoms of this are shoulder ache or pain in the upper arm.  Another common problem 
is the small and very precise movement of the fingers and wrist this will tire the wrist and result in 
constant pain and feeling of numbness in the hand, this condition is called carpal tunnel syndrome 
(CTS). Trust me on this one; I have already been on medication once to get rid of CTS. At Cornell 
University they have done research into the subject (http://ergo.human.cornell.edu/cumousetips.html) 
and have come up with 10 recommendations: 

1. Mouse Grip - don't throttle your mouse (it's already dead)! Hold the mouse gently to move it 
over a mousing surface.  

2. Mouse from the Elbow - don't skate or flick the mouse with your wrist. Make controlled 
mouse movements using your elbow as the pivot point and keep your wrist straight and 
neutral.  

3. Optimal Mouse position- sit back in your chair, relax your arms then lift your mousing hand 
up, pivoting at the elbow, until your hand is just above elbow level. Your mouse should be 
positioned somewhere around this point. Don't use a mouse by stretching to the desk or out to 
the side of a keyboard. With a flat mouse platform, position this 2-6 cm above the keyboard 
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and over the numeric keypad if you are right handed - you can easily move it out of the way if 
you need to access these keys. With a downward sloping mouse platform, position this close 
to the side of the keyboard so that you can use the mouse in a neutral wrist position. Position 
adjustable mouse platforms are commercially available (e.g. Humanscale, Proformix, Flexrest, 
3M etc.)  

4. Protect your wrist - if you look at the anatomy of the wrist it is curved away from any 
contact surface (you can easily see this by resting your hand/arm on a flat surface - you'll see 
light under the wrist and can probably even pass a thin pen under this). The forearm is shaped 
liked this for the wrist to remain free of surface pressure contact.  

5. Avoid restricting circulation - For many people there are exposed blood vessels near the 
skin at the wrist, which is where the pulse is often taken. Any pressure in this region will 
disrupt circulation into the hand and this will increase the risks of injury.  

6. Don't use a Wrist Rest - research has shown that using a wrist rest doubles the pressure 
inside the carpal tunnel, because the floor of the tunnel is a more flexible ligament that 
transmits external pressure changes directly into the carpal tunnel (the roof of the tunnel is 
bone so the pressure doesn't get transmitted on through the hand). Indeed, one test for carpal 
tunnel syndrome (CTS), know as Tinel's sign, simply involves tapping on the palmar surface 
of the wrist, which is enough to cause tingling and numbness in someone developing CTS.  

7. Avoid Restricting Arm Movement - with a softly padded wrist rest, especially one that is 
rounded, or a soft chair arm rest the forearm becomes "locked" into position and this 
encourages people to make mouse movements by flicking the wrist, which also increases 
intracarpal pressure.  

8. Keep the Mouse Free Moving - The base of the palm of the hand is the part of the body 
designed to support the hand when resting on a surface. For keyboard use a broad palm 
support is best. However, mouse use is different to keyboard use. With a keyboard the best 
posture is for users to float their hands over the keyboard when typing and then to rest on the 
palm support in microbreaks between typing bursts. You can use rest-breaking software (e.g. 
Magnitude ErgoManager, Break reminder etc) to help track and advise on your mouse use. 
With mousing this doesn't happen. A mouse is used by moving it's location over a surface, and 
resting usually occurs when mouse movements stop but with the mouse still being held in the 
hand. Mouse movements should be made using the elbow as the pivot point, not the wrist. 
Anything that impairs free movement of the forearm/hand and mouse will increase injury 
risks.  

9. Mouse shape - choose a mouse design that fits your hand but is as flat as possible to reduce 
wrist extension. Don't use a curved mouse. Use a symmetrically shaped mouse. Consider a 
larger mouse, such as the Whale mouse or the Perfit mouse, that encourage arm rather than 
wrist movements.  

10. Load sharing - if you want to load share between your right and left hands, that is using the 
mouse for some of the time with each hand. For this you need to choose a mouse platform that 
can easily be configured to the left or/and right, and a symmetrical shaped mouse that can be 
used by either hand.  

 
Priority of mouse arrangements 

• Best arrangement for a mouse is a platform over the number keypad and just above the 
keyboard.   

• Good arrangement is a pad on an angled platform to the side of the keyboard.   
• Poor arrangement is a flat surface to the side of the keyboard   
• Worst arrangement is on the desk out to the side of the keyboard.  

 

4 Fundamentals of the L-Edit user interface 
When starting L-Edit 10.12 a start-up screen pops up (Figure 2). A central drawing area used for 
drawing the figures takes up the major part, this is surrounded by a host of menus and information 
areas. The most important of these (Figure 3) are described in more detail in the following. The 
individual menus and palettes can be switched on or off by right clicking the mouse while the pointer is 
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in the menu area. Start by right clicking and remove the tickmark next to Command Line and 
Verification those menus will not be needed for now. 

 

Figure 2: The start-up screen when L-Edit 11 is first run. 

 

 

Figure 3: Location of various palettes 
and menus on the L-Edit user interface. 

 

4.1.1 Standard toolbar 

 
The standard toolbar is very much like in most windows program. There are a few more menu points 
such as the hierarchy view but these need not be used initially. 
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4.1.2 Locator toolbar 

 
The locator toolbar gives information of the mouse pointer position relative to origin. Clicking the unit 
dropdown menu can change the unit. Usually microns or mm are the most useful units. The zero on the 
numerical keyboard can be used to set a new origin, but should only be used with care since it 
influences how cells are instanced. The key “q” can be used to reset the locator and allows for 
definition of a new temporary origin without changing the actual origin. This may then be used for 
measuring distances between a given point and the mouse pointer. 

4.1.3 Drawing toolbar 

 
The drawing toolbar includes the drawing primitives. The first selection “the pointer” is used for 
selection purposes, and is the default for cell manipulation etc. 
The next selection “the rectangle” is used for drawing rectangles. The next three selections represent 
polygons with varying freedom in shapes. The first one only allows for 90º geometry (Manhattan), the 
second one allows for 45º angle geometry and the final one is completely free with regards to the 
angles. All polygons must be closed and not intersect itself. For examples of the rectangle and the three 
polygon types, see the first row of Figure 4.  
Next follows selections for wires, which are much like lines in regular drawing programs, avoid using 
wires if possible, since there is a problem with the definition of the ends. 
Following the lines are three selections for drawing arced structures, first is the disc, then a pie slice 
and finally a torus. Ignore the next 4 selections. 
The final possibility is the instance function, this is used to place one cell in another, this will be used 
often, it also has a shortcut key “i”. 

4.1.4 Editing palette 

 
The editing palette is only available when some objects are selected, the first 5 are simple duplicate, 
rotate, mirror buttons common for most drawing programs. 
The next four are for cutting parts of the structures. I find these four to be a bit hard to use. Try them 
out at some point and see if they suit your style of designing. 
Then comes the grouping function (two squares and four black corners. This can be used to place 
different structures (including cells) in a new cell. It should be noted that the structures are placed in 
the cell so that origin of the new cell and the original cell coincide. This only matters on occasion (like 
when rotating) but then it is quite annoying. 
 The ungroup function (two squares and 8 black corners) is used to remove the hierarchy information of 
a cell. Be careful when using this function, since sometimes a cell on a too high level in the hierarchy is 
chosen and thus the structure of the design may be damaged by flattening the cell (plus the filesize may 
increase significantly). 
The glasses activate the Edit Object(s) function, which is also available with ctrl-e or through the menu 
bar: Edit->Edit Object(s). 
The move function (x and y plot and a vector) can be used for moving a selection a precise distance. 
This function is really simple but also highly useful when making sure that structures are exactly where 
wanted. 

4.1.5 Verification Palette 
Remove it for now. 
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4.1.6 Layers palette 

 

The layer palette displays the various layers, which are available. Each layer can be 
turned into a mask but it need not. This means that some layers are used for the 
actual design, while others help the layout, the displayed grid, the origin cross and 
the drag boxes are drawn on specific layers. If more layers are needed they can be 
created and also the rendering of existing layers can be manipulated. 

4.1.7 Mouse buttons 

 

L-Edit operates best with a three-button mouse. The “mouse buttons” palette 
informs you what the mouse buttons will do. The behavior of the mouse changes 
depending on what different kind of control buttons are pressed, ctrl, alt, shift, z. 
This definitely takes some practice, and notice that L-Edit is designed for right-
handed people, there appears to be no good way around using the mouse with the 
right hand and operate the control keys with the left hand. 

4.1.8 Aerial view 

 

The aerial view shows you where the visible screen is compared to the rest of the 
layout, this is great if you have zoomed in too close or too far out. 

 

4.2 Drawing structures in L-Edit 
Structures in L-Edit are made up of drawing primitives. The drawing primitives represent fundamental 
figures such as squares, polygons, lines and circles (Figure 4). The actual process of drawing is by 
using point-and-click, in many ways resembling any drawing program for windows. One critical point 
is that all corners of figures correspond to grid points. The grid can be very fine, but each point is 
always on a grid point. 
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Figure 4: A collection of different structures with various complexities.  

4.2.1 Adding text to a design 
It is often desirable to have some text, especially for global and local identifiers. L-Edit has a built in 
tool to create text. The font is ugly but gives access to text in a simple manner. By choosing Draw-
>Layout Text generator it is possible to enter the desired text in the field: “Layout text string”. It is 
possible to choose, which layer the text should be placed on and also name the new cell, which will 
contain the text. Don’t be fooled by the scaling boxes or the other checkboxes they do not all work 
intuitively, and I suggest not using them. 
After having chosen “ok” you will be asked to click a “Center point”. Just click anywhere because you 
probably need to work on the alignment anyway. Now you have a cell with the desired text. You can 
open this and make sure the text is located correctly with regards to origin (I usually have lines of text 
aligned to origin, and single letters and numbers offset slightly from origin to make it easier to 
construct series with a decent spacing later). With the text correctly aligned the text cell can be placed 
at the desired location and resized (ctrl-e) to the size needed. 

 

Figure 5: Dialog box for inserting simple 
text in a layout. The box is opened by 
choosing: Draw->Layout Text Generator… 
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Hint. 
I use a naming convention for my text in files. The first word of the cell name describes what kind of 
text I am dealing with. I use the following: 

• “Letter:” for cells containing only a single letter 
• “Number:” for cells containing only numbers (may be more than single digit) 
• “Name:” for cells with words used as local identifiers 
• “Text:” for cells with words or text more than 1 letter long 
• “Symbol:” for cells with symbols such as: *, º, µ, λ. 

Then I name the cell after what it contains and finally if the layout uses more than a single masking 
layer I include the layer name in parenthesis. A cell could for instance be called: “Name: Channel 
length (Front etch)” 

4.2.2 Manhattan geometry 
The simplest geometry possible for mask designs are the so-called 90º geometry. When drawing 
designs using 90º-geometry there can be no structures with angles other than 90º. This geometry is 
often referred to as Manhattan geometry due to the way the streets are placed on Manhattan. 

4.2.3 Curves and “Why can’t I draw circles” 
For most microsystem designs it is vital to be able to draw structures having any angle and not be 
restricted to Manhattan or 45º geometry. Sometimes the circle symbol etc will be missing from the 
“Drawing toolbar” (section 4.1.3). Then it is necessary to change the drawing mode. This is done by 
selecting “Setup->Application…” in this menu on the “General” tab is the “Drawing mode” located 
under “Toolbars”. The drawing mode can also be accessed by right-clicking with the mouse pointer 
located on the “Drawing toolbar”. 
 

5 Navigating L-Edit 

5.1 Layers 
Each layer contains structures, which will be placed on the same photomask. Structures drawn on 
different layers do not automatically have any relation to each other (derived layers are an exception). 
This lack of relationship between structures on various layers is one of the reasons why there is no 
“Flood fill” function in L-Edit. Some of the layers in L-Edit are special layers, which are used for 
various purposes these layers are never turned into photomasks. The most important special layers are 
the “Origin”, “Grid” and “Drag Box” layers. The origin layer contains a cross indicating the coordinate 
(x,y) = (0,0), and that’s it. The “Grid” layer contains dots indicating the drawing grid. The grid settings 
can be changed using the menu Setup->Design->Grid. 

5.1.1 Copying a structure from one layer to another 
Sometimes it is desirable to copy a structure (or number of structures) from one layer to another. It is 
done like this: 

1. select all the structures which should be copied 
2. click “Edit->Copy” or ctrl-c 
3. make the target layer the active layer (click it in the layers palette) 
4. choose alt-v (yes alt not ctrl) 
5. copies of the structures is then inserted on the active layers and are automatically selected. 

 

5.1.2 Changing colors of layers 
In principle it is straightforward to change the colors of the layers in L-Edit, however in practice it is 
often a bit challenging to get good results, this is an advanced subject. 
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5.2 Cells 
A cell is a collection of drawn structures. The structures in a cell can be on any or all of the available 
layers. Empty cells can also be created but they generally lead to confusion and so should be avoided. 
Cells can be placed within other cells as shown previously (Figure 1). This creates a hierarchy among 
cells, which means that some cells may not be inserted in others. If for example the cell “Small 10 
micron Resistor” is inserted in the cell “Wheatstone” then “Wheatstone” may not be inserted into 
“Small 10 micron Resistor”. L-Edit handles this automatically and will not allow descendant cells to be 
inserted into ancestor cells. The example above was quite obvious but sometime the designer may be 
surprised that a particular cell may not be instanced into another, most likely it is because the designer 
tries to instance a descendant into an ancestor. 
The cells drawn are placed in the database file (*.TDB) but not all cells in the file are turned into 
masks. Only cells placed on the so-called “Fabrication cell” and their ancestors are turned into useful 
mask data. This is due to the database structure of the file format: Unless it is clearly defined what is to 
be turned into a mask and how everything relates to it, garbage would be the result. On the other hand 
the database can also be used for drawing cells and then later instancing them. The database format 
gives a lot of flexibility for the added trouble of having to define a “Fabrication cell”. The fabrication 
cell is the one lowest in the hierarchy (cell: Wafer level in FIG), it is defined by choosing “Cells-
>Fabrication Cell” and then selecting the desired cell. The fabrication cell is indicated in the cells menu 
with a purple script F. 

5.2.1 Instance – I or Ins 
When one cell is placed into another cell it is done by “instancing” it. Instancing can be don by either 
chosing the i-key, insert-key, the instance button on the drawing toolbar or “Cell->Instance”. The 
instance command is the backbone of structured design and that is reflected in the many possible ways 
of choosing this command. 

5.2.2 Edit object(s) – Ctrl-e 
The command “Edit->Edit object(s)…” opens to a very important menu. With this details of each 
object can be modified. This can for instance be the exact position of an object or the size and shape of 
it. The same command is used for all objects but it opens up to several different sub menus depending 
on the object. 
Arrays of cells can be placed in a cell using this command, an instance of the desired cell is chosen and 
then the number of times it should be repeated in each direction is entered in the submenu. Also in the 
“Edit object(s): Instance” submenu are controls for defining rotation or scaling of the instance. The 
scaling requires a bit of explanation: The menu point holds two values, one on top of the other, 
between the two is a line. This line should be interpreted as a division line where the upper value is the 
numerator and the bottom value is the denominator. This means that entering the numbers 6/1 will 
make the instance six times larger in all directions whereas 6/6 will make the instance have the same 
size as the original cell (in effect doing nothing). 

5.2.3 Other useful cell commands 
A number of different other ways to manipulate cells also exists, these are accessed from the menu 
“Cells”, these include “Rename”, “Deleting”, “Flatten” and “Fabrication Cell” 
 

5.3 Setup 

5.3.1 Scale 
Each drawing window can be magnified and demagnified. The “+” and “-“ keys on the numeric 
keyboard can be used for changing magnification. The mouse can also be used if “z” is pressed first 
and the pointer is used to create a dragbox, the area in the dragbox will then be magnified to fill the 
screen. To get a global view of a cell the key “Home” will make the whole cell fit into the window. The 
ability to fit the whole cell onto the screen can be very useful to find errors in the design, such as 
structures drawn far away from the actual important structures. 
Zoom range is a property of each open window. This means that the same cell can be open in two 
windows at different zoom range. This is very useful since otherwise even more zooming operations 
would have to be performed. 
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6 Mask design specifics 
To make a good mask design there are a couple of points, which should be incorporated or at least 
consciously ignored. This section deals with issues such as identifiers and test structures. As a running 
example is used a simple mask for etching a microfluidic channel structure (Figure 6). 

 

Figure 6: A plot of a front-side mask. Details 
from this mask are used as examples 
throughout this section. 

6.1 Global identifiers 
A global identifier is a large structure, which is used to make processing and handling of the wafers 
easier. With a global identifier it is easy to figure out how the masks should be turned and whether the 
mask and wafer correspond to each other. The use of a version number in the global identifier makes it 
easy to change one mask and still keep track of which mask has been applied. In the example, there are 
several global identifiers (Figure 7), the logo “MIC” and the mask set name and version number. 
Another global identifier, which can be very useful, is to include the names of the designers. This 
means that wafers are less likely to get lost during fabrication. 

Figure 7: The global identifiers from the 
mask shown in Figure 6. 

 
 

6.2 Local identifiers 
A local identifier is a structure, which identifies a chip or a substructure. It can either be on micro-
scale, for instance giving information about dimensions of a particular structure, or it can be on macro-
scale, being readable by the naked eye. Structures on micro-scale can have any size that can be 
resolved by the lithography and subsequent processing. Macro-scale letters should not be much less 
than 1 mm high. 

6.3 Alignment marks 
In some cases, it can be a great advantage to use a mask to define some alignment marks for the 
following masks. This can for instance be the case where the alignment mark mask allows more 
freedom in the order of the following masks. It may also be the case that the subsequent masks cannot 
hold alignment structures because the processing of these layers will destroy any fine marking (for 
instance deep isotropic etches). When designing the alignment marks it should be stressed that they 
should be easy to find, easy to use, hard to misinterpret and not vulnerable to processing. Two sets of 
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alignment marks are used, one on the left-hand side of the design and another on the right-hand side. 
For highest precision the distance between alignment marks should be as large as practically possible. 

 

Figure 8: A part of an alignment structure. On the left-hand side is shown 5 structures for aligning 
other masks to this one. On the right-hand side is shown a structure for aligning the front-side to the 
back-side. The width of each line is 10 µm. 

On some aligners the field of view may be as little as 200 µm square so to assure that alignment marks 
are easy to find, it is necessary to have distinct helping structures to guide the aligner-operator to the 
alignment marks, such as arrows and pointers (). Designing alignment marks for ease of use is a matter 
of experience and also personal preference. An example is shown of a reasonably easy to use structure. 
Each of the five alignment structures consists of seven bars surrounding two squares of unequal size. 
The bars are on the alignment mask and the squares are on the mask to be aligned to the alignment 
mask. The five structures are different in that the central bar has a different length from its neighbors. 
The pattern shown is the left-hand side structure; a mirrored version is placed on the right-hand side. 
The configuration with mirrored versions and two unequal-squares as the alignment object means that 
it is immediately obvious if the wrong mark is used or if the mask/wafer is placed upside down in the 
aligner. Preventing such simple handling mistakes is quite simple if done in the design phase but a lot 
harder to do later on. 

6.4 Test structures 
Test structures are structures on your mask, which are not part of the components or of the 
embellishments. There are two different types of test structures: Process monitors and experimental test 
structures. A process monitor is a structure, which you can use to check the processing. It is a structure 
where you know what shape it should end up with after processing. These structures can be very simple 
lines (see Figure 9) or highly complex patterns, the design depends strongly on the lab practice and the 
amount of time used on developing good process monitors. 
Experimental test structures are structures placed on the mask because they will provide some useful 
information for future work. This could for instance be a series of corner compensation structures for 
KOH etching. If the mask is going to be etched in KOH the corner compensation structures can be 
analyzed to reveal the optimum structure. In this way you do not have to order a specific mask for the 
test purpose. This saves both time and money, because you will be processing the wafers the same way 
as before but now you get additional information without getting a new mask or doing a specific 
process aimed at realizing the test structures. 
You should include test structures. They will almost always be worth the effort put into them. 

 

Figure 9: Some of the test structures on Figure 6. 
These are process monitors used to check the 
influence of linewidth on dry etching 
characteristics. 

6.5 Embellishments 
Embellishments are structures that only have decorative purposes. They do not serve to help the 
navigation of the layout, nor are they actual components or test structures. These structures are 
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obviously not necessary for the design to work, however, there are a couple of reasons why you might 
want to include such structures anyway. One thing is to make sure that when pictures are made of the 
chip, your name or institution will show up. This is actually a quite important point since it is 
essentially free advertising should you make nice designs and pictures. Embellishments are also very 
good at demonstrating joint efforts. In the example (Figure 10) the embellishments demonstrate that 
this chip has some connection to MIC and that it was created as part of a co-operation between µTAS 
and Bio-Array. 
 

 

Figure 10: Some of the embellishments from chip 
9 of the mask shown in Figure 6. 

 
The final point of embellishments is the pure excitement of making very small pictures. I can’t explain 
it but small pictures are fun. Check out the web for small pictures on chips and check out what 
Motorola and Intel have snuck unto chips (http://micro.magnet.fsu.edu/creatures/). 

6.6 Choice of chip size 
A chip is a part of the wafer, which can be used without the rest of the wafer. In many cases the desired 
components are quite small and so several can fit on a wafer. When the chips are separated from each 
other it is usually done either by dicing (with a saw) or cleaving along weak crystallographic directions. 
This means that the cuts will extend all the way across the wafer. In most cases the best (easiest) shape 
is rectangular with one side parallel to the flat of the wafer.   

6.6.1 Monitor chips 
Sometimes it is worthwhile to reduce the number of component chips and instead add specific chips 
with a large number of test structures. This should especially be considered if the chip-size is very 
small (meaning the chip-count is high) or if the design is used in the beginning of a process 
development. Since the monitor chip can replace a component chip completely it is simple to place it at 
various distances from the center of the wafer so as to be able to check the uniformity of processing.  
The use of well-designed and placed monitor chips means that the quality of processing can easier be 
checked from fabrication run to fabrication run. 
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7 Mask polarity and orientation 
When ordering masks the polarity and orientation must be specified. In some cases the location of 
chromium is also indicated (Figure 11). The description of how the mask should be fabricated is 
important because in some cases of dual-sided designs, the pattern must be drawn mirrored to make 
sense. 
When ordering masks and determining polarity it is important to find out if the polarity in the mask 
manufacturer jargon refers to the drawn structure (Compugraphics) or the field i.e. surroundings of the 
drawn structures (Delta Mask). 

 

Figure 11: Explanation of the mask polarity and orientation attributes for mask ordering. The mask file 
pattern is drawn in L-Edit and depending on the polarity (bright or dark) and the orientation (“right 
reading” or “wrong reading”). The short form of the ordering information is also shown for each 
mask. Note that CU/RR is the same as CD/WR and can be used depending on what is most convenient. 
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To visualize why the orientation is a useful tool; take a look at Figure 12. Here is shown a simplistic 
design where one mask is supposed to be used on the back side and the other on the front (a). in figure 
(b) the masks are shown as one would like them (notice that the reading is different). In (c) both masks 
are shown with the same reading. It is obvious that this choice of orientation does not produce the 
desired structure. The alternative is to draw one of the masks mirrored, but that is very tiresome and 
prone to generate errors. 
 

 
(a) 

 
(b) 

 
(c) 

Figure 12: Why reading becomes important for dual sided mask sets. A simplified mask set is shown in 
(a). Here there is a front side and a back side mask, which each has their own color, with the 
overlapping structures having a third color. One correct way of reproducing this mask set as 
photomasks  is shown in (b). A wrong way of doing it is shown in (c) where the same set of orientation 
is choosen for both the front and the back side mask. 
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8 “End of chapter” questions and exercises 
The first part of these questions deal with theoretical considerations when designing masks. The second 
part is a series of hands-on L-Edit exercises. 

 
A. This exercise focus on the design of alignment marks and the considerations needed for 

designing good alignment marks. In the table there are two pictures of alignment marks on 
each row. The first structure is on the wafer and the second is on the mask. This mask is 
supposed to be aligned to the structure in the first picture. The mask contains the drawn 
objects in the mask layout program (black means “drawn in program”, for a clear field mask 
the black structures would be chromium). Then further along the row is a description of the 
polarity of the mask. 

1. Does it matter if the pattern on the wafer is dark or bright where the structures 
are shown as black? 

2. For each row please describe if this is a useable set of alignment marks, for each 
mark also indicate if it is a good mark if the polarity of the mask is changed. 

 
Number Pattern on wafer Pattern on mask Mask 

polarity 
Ok + 
Bad - 

Fixed by 
changing 
polarity 

Needs 
more 
help 

1 

  

Dark 
field 

   

2 

  

Dark 
field 

   

3 

  

Clear 
field 

   

4 

  

Dark 
field 

   

5 

  

Clear 
field 
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6 

  

Dark 
field 

   

7 

  

Clear 
field 

   

8 

  

Clear 
field 

   

9 

  

Clear 
field 

   

10 

  

Clear 
field 

   

11 

  

Dark 
field 

   

12 

  

Clear 
field 

   

13 

  

Dark 
field 
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B. Consider that you are designing a mask set for an aligner with two microscopes which each 

has a field of view of 200 µm width and 300 µm height: 
1. How large a fraction of the wafer surface of a 100 mm diameter wafer can then 

be seen in the microscopes? 
2. Would you expect an alignment mark filling the field of view to be easy to find? 
3. In an aligner the mask can be manipulated in the x- and y- direction 

independently of each other. Can you suggest some structures, which can be 
added to the alignment mark to make it easier to find? Please be precise with 
respect to dimensions and location. 
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